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Introduction
General Overview

The Defense Medical Surveillance System (DMSS) is the corporate executive
information system for medical surveillance decision support in the EI/DS
business area of the Military Health System (MHS). The DMSS receives and
integrates standardized data from multiple individual Service and DoD sources
worldwide. The "engine" of the DMSS is a continuously growing relational
database of up-to-date and historical data related to medical events (e.g.,
hospitalizations, outpatient visits, reportable diseases, HIV results, health risk
appraisals, immunizations, deaths), personal characteristics (e.g., rank, military
occupation, demographic factors), and military experiences (e.g., deployments,
assignments) of all Army, Navy, Air Force, and Marine service members over
their entire military careers. There are currently more than 300 million rows of
data regarding more than 7.8 million service members in the online DMSS
database.

The Defense Medical Epidemiology Database (DMED) application provides
authorized users worldwide (through the Internet) with real-time access to user-
definable queries of a subset of data (nonprivacy) contained within the DMSS.
The DMED application can be downloaded from the Army Medical
Surveillance Activity's (AMSA) home page (http://amsa.army.mil).

The purpose of the DMED is to standardize the epidemiologic methodology used
to collect, integrate and analyze Tri-Service personnel and medical event data
and to provide authorized users with remote access to the summarized data.
Through the use of client-server technol ogies and database optimization, DMED
users have unprecedented capabilities to access Tri- Service epidemiologic data
and to submit tailored queries that are responded to in atimely (seconds) and
efficient manner.

DMED is available to all military and civilian researchers, policy makers and
others with a need to evaluate the health of active duty service members.

What’'s new

> Addition of 2004 to current year data.
» Addition of 2003 to last 10 Years.
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Key Information
Data Sources

DMED provides remote access to a subset of data contained within the Defense
Medical Surveillance System (DMSS). DM SS contains up-to-date and historical data
on diseases and medical events (e.g., hospitalizations, ambulatory visits, reportable
diseases, Immunizations, HIV tests, etc.) and longitudinal data relevant to personnel
characteristics and deployments experience for all active duty and reserve component
service members. The DMED application provides a user-friendly interface through
which users may perform queries regarding disease and injury rates and relative
burdens of disease in active duty populations.

DMED provides access to four types of datarelevant to active duty service members:
demographic data, inpatient hospitalization data, ambulatory data, and reportable
events data.

Demographic data (i.e., gender, race, marital status, pay grade, etc.) are provided by
the Defense Manpower Data Center (DMDC). DMDC receives updated data on a
monthly basis on each Service.

Hospitalization data are provided by the Executive Information and Decision
Support (EI/DS) Program Office. These data are a subset of information from the
Standard Inpatient Data Record (SIDR), which records inpatient treatment data. SIDR
data are collected by the Composite Health Care System (CHCS) at each DoD
Medical Treatment Facility (MTF) and the outsourced (non-DoD hospital) in-patient
healthcare provided to active duty service members. For each hospitalization of an
active duty Service member in an U.S. military hospital, at the time of discharge, up
to eight diagnoses are recorded (using standard diagnostic codes, International
Classification of Diseases, 9th revision). The first diagnosis is generaly indicative of
the primary reason for admission and is the diagnosis code that is reflected in the
DMED data

Ambulatory data are provided by the Executive Information and Decision Support
(EI/DS) Program Office. These data are a subset of information from the Standard
Ambulatory Data Record (SADR), which records patient-level outpatient treatment
data generated by the MTFs and the outsourced (non-DaD clinic) out-patient
healthcare provided to active duty service members. For each outpatient visit of an
active duty Service member up to four diagnoses are recorded (using standard
diagnostic codes, International Classification of Diseases, 9th revision).

Reportable Event data contains information on 70 reportable medical events. This
datais reported to the DMSS by the Services Medical Surveillance Centers. Army
reportable event data for calendar years 1995 to present, and Navy and Air Force data
from calendar years 2000 to present are available in DMSS.
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Disclaimer

The Defense Medical Surveillance System (DMSS) is an executive information decision
support system whose database contains up-to-date and historical data on diseases,
medical events (e.g., hospitalizations, ambulatory visits, reportable diseases, HIV tests,
immunizations and health risk appraisals) and longitudinal demographic data on DoD
personnel. Data in DMSS originates from many different sources within the DoD. DMED
provides authorized users comprehensive remote access to a subset of nonprivacy data
contained within the DMSS.

The overall quality of medical surveillance data depends on completeness, validity,
consistency, timeliness and accuracy. With over 300 million rows of data (from more
than 20 different sources) currently in DMSS, much effort is made to ensure a
standardized and consistent approach to data processing and validation. However, receipt
of large data inputs from multiple sources makes it impractical to correct all inaccurate or
miscoded records. The following are known characteristics of the data available through
DMED.

Population Statistics:

All data on DoD service members contained in DMSS is validated against DoD

personnel data obtained from the Defense Manpower Data Center (DMDC). Stratum data
elements (i.e., gender, age, grade, race/ethnic, and marital status) for a medical event are
derived from personnel data considered to be current on the date of a medical event.
Overall and stratum-specific population statistics (i.e., person year denominators) are
calculated based on longitudinal personnel data. Stratum-specific unknown (or missing)
data are excluded from all calculations.

I n-patient Data:

In-patient data for calendar years 1990 - 2003 and monthly data for calendar year 2004 is
a combination of the Standard In-patient Data Record (SIDR) extracted from the
Composite Health Care System (CHCS) used in DoD Military Treatment facilitates
worldwide and outsourced (non DoD hospital) in-patient healthcare provided to active
duty service members. CHCS exists primarily as an administrative medical database, but
it allows tracking of frequencies, rates, and trends of disease and injury diagnosesin
military populations. Each medical record is coded with up to eight diagnoses and is
based on the health care provider's review and interpretation of results of tests, consults,
and diagnostic and therapeutic procedures. Only those in-patient records considered
complete are processed into DMSS.
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Ambulatory Data:

Out-patient data for calendar years 1997 - 2003 and monthly data for calendar year 2004
is a combination of the Standard Ambulatory Data Record (SADR) extracted from the
Ambulatory Data System (ADS) and the Composite Health Care System (CHCS) used in
DoD Military Treatment facilitates worldwide and outsourced (non DoD clinic) out-
patient healthcare provided to active duty service members. ADS exists primarily asan
administrative medical database, but it allows tracking of frequencies, rates, and trends of
disease and injury diagnoses in military populations. Each medical record is coded with
up to four diagnoses chosen from alist of relevant diagnosesfor specific clinics. Clinic
staff fill-out patient encounter information (including diagnosis) onto forms that are
scanned into the ADS database. Only those out-patient records considered complete are
processed into DMSS.

Reportable Event Data:

Medical events meeting DoD reporting requirements are transmitted within each Service
to a central location by Service-specific reporting programs. These programs exist to
compile a reportable event surveillance database used to record and track events of
interest in the military. Criteria (below) were formulated by each Service to establish a
consensus list of DoD reportable events. Army reportable event data for calendar years
1995 to present, and Navy and Air Force data from calendar years 2000 to present are
available in DMSS.

Criteriafor the Selection of Reportable Medical Events

First, there must be a clear case definition and a single standard code (in the
International Classification of Diseases, 9th revision);

Second, an intervention must be available and/or a public health response
indicated;

Third, a sufficient, timely source of information must not already exist; and

Fourth, the condition/event must:

represent an inherent, significant threat to the public's health (e.g., potential to affect
large numbers of people, to be efficiently transmitted within a population, to have
severel/life threatening clinical manifestations); OR

represent a significant military operational threat (e.g., potential to disrupt
military training, deployment, or operations); OR

be commonly reportable by state or federal laws, regulations, or guidelines.

4
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Information about query results

Switching tabs

Results tabs for Disease Summary and Detailed Queries will have five sub-tabs
(seeFigure 1):

Counts - displays the count of the cases for the population substrata selected.
These are the numerators of the rate calculations.

Person Years — displays the cumulative person years of experience during the
calendar years of interest of all members of the population substrata sel ected.
These are the denominators of the rate calculations.

Rates - displays rates of occurrence of cases (rounded to 2 significant digits) for
the popul ation substrata selected.

Line Chart - graphs the ratesin line chart format.

Bar Chart - graphs the rates in bar chart format.

MDMED 3.6 Detailed Query: Hospitalizations

ICGC-9 Explorer Population Filters Display Results
Intmductionl Hospltallzatlons - Cases of Selected Dlagnoses
Data Bource: Hospitalizations Condition: Primary Diagnosis Oecutrenices: All
Dizease Gender:  All Grade: All
Bt ary Age: Al Dlarital Status: Al
Detailed Race: All Setvice: All
Query Calendat Vear: 1990-1959
Location: All
Top Ten
4 Oocupation: A1
Fopulation
Counts Person-Years Rate Line Chart Bar Chart
u Hubmit 1000 | 1091 | 1902 | 1903 | 1094 | 1095 | 1906 | 1907 | 1008 | 1090 | Teial
Cuery Army | 2114] 2092) 2231| 2076 1858 1781 1624 983 T14| 7Ta6|16,220
: MNavy 12800 1.236| 1,25 1,269 1,163 1,108| 1027  ¥6Y] 507 46%|10,081
Query History AirForee| 1,554 1571 1460] 1,207 1254 1,191] 1,200  7Ta4] 514 53111345
harines 324 37s| 315] 318] 230)  394|  283] 191] 159 134] 2,551
Total | 5272 5174) 5261| 4950( 4514 4374) 4133 2705 1204 1.599140,186
File
Frint
Hel X
413' Figure EI
Ezit |

Huotes : Bates are caloalated per 1000 - persons peryear. Data with imbrommerahoes sochaded.

*Selected Diagnozes
1. 140-230 HEOPLASTHE

oA

L]

Sonrce: DMSS 16-Hhr-2004
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Changing rate calculations

All ratesin DMED query results are calculated per thousand persons per year and
rounded to two decimal places. When arateis calculated to less than .01 per
1000, the displayed rate as <0.01. In such instances, an exact rate can be
manually calculated by dividing the relevant count(s) by the corresponding

personttime(s). The formulais:

Rate = counts/ person-time * 1000

DMED provides the ability to change the scale of the rate calculation through the
drop down box located at the bottom of the Results tab (see Figure 2).

m DMED 3.6 Detailed Query: Hospitalizations

1CD-9 Explarer Fopulation Filters Display Results
T T = q *
Immdumonl Hospitalizations - Rates for Selected Diagnoses
Data Bource: Hospitalizations Condition: Primary Diagnosis Oceutrences: All
Disease Gender: Al Grade: Al
Summaty Age: All I atital Status: Al
Dietailed Race: Al Gervice: Al
Cuery Calendat Year: 1990-1900
Location: Al
Top Ten
4 Occupation: Al
Population
Counts Person-fears Rate Line Chart Bar Chart
E Bubmit 1000 | 190] | 1002 | 1903 | 1004 | 1005 | 1095 | 1997 | 1008 | 1999 | Total
Caery Army | 286 3.78| 426 359 339| 345 332| 204 150) 143 3.02
; MNavy 223 216) 231 250 247 253 246) 195 134 129 216
Shuery History AirForee| 200| 305 306| 203 205 297 310 203 141 1.49] 245
Marines | 166) 137 165 1.77 137 170] 163 110 093] 0.92] 1.40
Total 2.58| 281 303 290| 2.79| 286 282 190) 136 1.40] 2.49
File
e Figur
Help |
Exit |

Huotes: Bates are caloalated per | 100

qj b r
J 1. 140-230 NEOPLASME

*5elected Diagnoses

;I perscis peryear. Duta withomdeomm mabies eochided.

Sonmce: DMES 16-Iar-2004
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Unknown / missing data

Unknown values are included in calculations for strata where All is selected.
However, unknown vaues are not included in calculations for strata where

multiple discrete values are selected.

Small cell counts

DMED summarizes experiences of groups of individuals. It does not provide
access to individual patient (Privacy Act) information. Because of this, DMED
requires aminimum of 10 person years per table cell in order to calculate results.
If less than 10 person years of data are available, results are not totaled and * * is

displayed in the appropriate cell in the table (see Figure 3).

m DMED: 3.6  Detailed Query: Hospitalizations

1CD-9 Explarer Fopulation Filters Display Results
Immdumml Hospitalizations - Cases of Selected Diaghoses
Data Bource: Hospitalizations Condition: Primary Diagnosis Occutrences: All
Disease Gender: Al Grade: Al
Surmmary Age: Al Ilarital Btatus: Al
] Race: Al Service: All
Detailed
Quety Calendar Year: 1994, 1993, 1996, 1997, 19958, 1999, 2000, 2001, 2002, 2003
Location: AKO0 = ALASKA
Top Ten
' Gecupstion;  OALL = OFFICERS
Population
Counts Person-fears Rate Line Chart Bar Chart
E Submit 1994 | 1995 | 1904 | 1997 | 1998 | 1009 | 2000 | 2001 | 2002 | 2003 | Total
Query El-F4 i i & e 25 i 5 = 25 i 5
ey oLosWiwm| 2 0 2 1 o o o 1o i 3
04 0904 W5) a a i] 0 i 0 1 1 i 0 4
Total e e o = . o o = = e =
File »
Frint -
= Figure 3.
Help |
Exit |
d
% Huotes: Bates are caloalated per |1.000 d percons peryear. Data writhuelewnm mabaes sochuded. ** < 10 Percon- Vears . Soumrce: DHES 16-Mar-2004
*Selected Diagnoses
] 1. 300-316 NEUROTIC DI ORDERPERS ONALITY DIS ORDER,OTH HONPS Y CHOTIC MENTAL D-0RDER

Login / Password Information

Forgot password

If you have forgotten your user id or password contact the DMED administrator via email

at dmedadm@amsa.army.mil.

Updates / New Releases
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DMED tables are periodically updated monthly as new datais received. This may
cause query results to change slightly.

Most DMED software updates are transparent to the user. If an update to an existing
version of the software requires user acceptance, a message may appear when you log on
to DMED. User will then have the option of updating their DMED software before
logging in or cancelling the DMED login.

Getting Started with DMED

Types of Queries

There are four different types of queries possible with DMED. Within each query there
are multiple filters and other functions to customize each query.

Disease Summary Displays all available hospitalization, ambulatory and reportable event
data on a particular condition(s) in a specified population. Not all filters and display
options are available with 'Disease Summary'. However, the user can easily jJump from
the 'Disease Summary' query to a more detailed 'full-featured' query.

Detailed Query Provides data separately on hospitalizations, ambulatory data and
reportable events. The user can filter the request to include all occurrences of a particular
condition or just the first occurrence (eliminates multiple encounters for the same
condition).

Top Ten Diagnoses Displays the ten most commonly occurring medical encounters (in-
patient, out-patient or reportable event) for specified populations. For hospitalization and
ambulatory data queries, afilter is available to limit the scope to one or al of the mgor
|CD-9 diagnostic categories. As with 'Detailed Query', population filters for location and
occupational groups are available to define more specifically the population of interest

Population Statistics Provides demographic data on a specified active duty population.
Allow quick filtering of location and occupational groups to more specifically define the
population of interest. The results of this query are also available on the results tab of the
'‘Disease Summary' and 'Detailed Query'.

Data Sour ces

There are four main sources of data available through DMED. Refer to the ' DMED
Disclaimer' for additional information on these data sources.

Population Data All data on DoD service members contained in DMSS is vaidated
against DoD personnel data and obtained from the Defense Manpower Data Center
(DMDC) on amonthly basis. Stratum data elements (i.e., gender, age, grade, race/ethnic,
and marital status) for medical events are derived from personnel data considered to be
current on the date of amedical event.
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| n-patient Data In-patient data for calendar years 1990 - 2003 and monthly data from
calendar year 2004 is a combination of the Stardard In-patient Data Record (SIDR),
which is extracted from the Composite Health Care System (CHCS) used in DoD
Military Treatment Facilities worldwide and outsourced (norntDoD hospital) in-patient
healthcare provided to active duty service members. Each medical record is coded with
up to eight diagnoses and is based on the health care provider's review and interpretation
of results of tests, consults, and diagnostic and therapeutic procedures.

Ambulatory Data Out-patient data for calendar years 1997 - 2003 and monthly datafrom
calendar year 2004 are obtained from the Standard Ambulatory Data Record (SADR)
which is extracted from the Ambulatory Data System (ADS) and the Composite Health
Care System (CHCYS) used in DoD Military Treatment Facilities worldwide and
outsourced (non-DaoD clinic) out-patient healthcare provided to active duty service
members. Each medical record is coded with up to four diagnoses chosen from alist of
relevant diagnoses for specific clinics.

Reportable Event Data Medical everts meeting DoD reporting requirements are
transmitted within each Service to a central location by Service-specific reporting
programs. These programs exist to compile a reportable event surveillance database used
to record and track events of interest in the military. Currently, Army reportable event
data for calendar years 1995 to present, and Navy and Air Force data from calendar years
2000 to present are available in DM SS.

Application overview

Program Functions The main functions of DMED can be accessed through buttons
located vertically down the left side of the screen. Select the button for the type of
function you would like to perform. Buttons with drop down menus (e.g., 'Detailed
Query and 'Top Ten Query') are indicated with an arrow

1. Customizing Queries To facilitate creating a query, each query screen is set up as
aseries of tabs (e.g., ICD-9 Explorer, Population, Filters, Display, Results). Move
left to right through the tabs to select the desired information on each tab. One or
more population values can be selected independently. Location and occupational
group filters allow the user to specifically define the population of interest. One or
more location and occupational group values can be selected (maximum of five
selection for each). Choose how the rates are calculated by selecting the x-axis
and by-value from the radio buttons in the display tab.
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BT DidED 2.6
Welcome | Gt Staited | Disciine: |
Lrken duesrtices
Thzeas
Fammary
Daiadled
Cuiay
Top Teo
]
Fopulabion
oy
Cruey
Queny Hishory] Welcome to DMED! This program provides remote access to data
contained within the Defense Medical Surveillance System (DMSS).
R Using the tools avallable, you can construct customized queries of
: DOD Hospitalizations, Ambulatory clinic visits and Reportable Events.
Prics
= Choose ‘Getting Started' For a review of DMED [Versins 10 Features
ﬁ and assistance in constructing queries,
Exit
For CUSEOIMer SUDDorT, comtact mmmm# m .
-
N

2. Submit Query When you are ready to submit your query to the database, click the

Submit Query button on the left side of the screen. The results of your query will
appear on the Results tab. For more complex queries involving specific selections
of Location(s) and/or Occupational Groups, more time may be needed to execute
your query, approximately 1 - 3 minutes. At this time, you will be prompted with
adialog box with thisinformation. Y ou may choose to continue or cancel your
guery. In addition, you can choose to disable the dialog box for future queries.

Displaying Results Results can be displayed as a table of counts of the medical
events chosen, or as calculated rates. Disease rates can be displayed in either
tabular or graphic format. Population statistics (personyears) are also available
on the results screen. Current year results will display as counts only.

10
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M DMED 3.6 Query History

Select from most recent queries (max. of 10): j ﬂ ﬂ ﬂ ﬂ ﬂ J ﬂ ﬂ ﬂ

= Hospitalizations - Cases of Selected Diaghoses™
Introduchonl
Diata Source: Hospitalizations Condition: Pritmary Diagnosis Ocecutrences: All
Disease Gender:  All Grade: All
Summary Age: Aldl Mlarital Status:  All
m" Race: Al Service: All
5;;; Calendar Vear: 1994, 1995, 1996, 1997, 1008, 1909, 2000, 2001, 2003, 2003 Tump to Query
— b Location: Al
TopTen
L4 Oecupation: Al
Fopulation
Counts Person-Years Rate Line Chart Bar Chart
Submit 1004 | 1005 | 1994 | 1907 | 1004 | 1000 | 2000 | 2001 | 2002 | 2003 | Total
Cluery Army 46| 4=4) 530) 443 413 343| 326| 326| 306|372 4008

Navy 365 361|  310{ 275 223) 248 243] 224| 184|199 2633
Query History AirForce | 313| 200| 220| 206| 201) 220| 215 209 251] 242| 2376
e Marines | 106| 00| 73] 77 84| 89 79| A3 A% A0] T93

Total |1330] 1225 1,151]1,001) 922) B900| 263| 524 211 £73|9.900

1] Huotes: Bates are caloalated per | 100 d persons peryear. Data athomboromm wahies sochided. Sonmrce: DRSS 16-Mar-2004
*Selected Dhagnoses
p. D 1. 390392 ACUTE RHEUMATIC FEVER

2. 401-405 HYPERTEHEIVE DISEASE

t 3. 420-435 OTHER FORMS OF HEART DISEASE

Supplemental Information

1. Query History Retains the ten most recent queries you have performed during a
session. Access the query history function through the Query History button on
the left side of the screen. The Query History screen will display the results of the
most recently run query. There will be numbered buttons across the top allowing
you to select up to ten previoudy performed queries. Each Query History screen
has a'Jump to Query' button, which will take you to the full query.

2. Saving gquery results Query results can be saved to afile and reactivated in
DMED at alater date. Query results can also be exported for use in spreadsheet
programs such as EXCEL . Access these options through the File button on the left
side of the screen.

3. Printing query results Any results screen can aso be printed directly from
DMED by clicking the Print button. The displayed results selected will appear on
the printout. Choose landscape mode to view the entire printout.

4. Export Data Results from queries can be exported into a text file, which can be
easily imported into Excel or other data management software.

11
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Disease Summary

Overview
The Disease Summary feature gives the user the opportunity to view al
surveillance data (hospitalizations, ambulatory, reportable events) available for a
particular condition.

Choose diagnosis of interest

The user may select up to 15 ICD-9 code(s) or ranges of codes from the ICD-9
Explorer tab. The ICD-9 Explorer is atree structure of 1CD-9 codes.

Clicking on the + sign next to a displayed range expands the display to show the
next level of detail. Select codes or code ranges by clicking on them with the left
mouse button. Y our selection(s) will be highlighted and appear in the Selected
Codes box on the screen. To select (or deselect) multiple codes, hold down the
Ctrl key and click on each desired code (see Figure 6).

m [WAER 3.6 Dedailed Qoery; Ambulatory Data

W09 Explorer ] Fapulation ] Fiiters ] Cizplay | Reauts ]
Tatradartin| po =20
- e BEAROH |
sI::::z;r Sy D04 08 0L DISERSES AN INJURIES Dmgnoai Fiakda bo Search:—
| Datated | |2 : : {8 Primary Cisgen s
Cusey | | @ (20 140-238 NEOFLABME ™ Ay Disgooss®
Top Ten e ;l 240-2T9 EMDOCRIME, HUTRITICHAL ARC METABOLIC DISEASER, AMD IMMLIMITY |
| H =@ :l 280-229 DIZEASER OF THE BLOOO AMD BLOGC-FORMIMG ORGAKS 4 Appliardn Thashs Cadas Dy
Pepuation | | (50 290-318 MENTAL DISORDERS
30339 DISEASES OF THE MERYOLIS SYSTEM AND SEMEE ORGANS Selecisd Codes
- = -::-.. AR DISEASER OF THE CIRCLILATORY SYSTEM MTEEE]
i3 %ﬂ;—t (BRI 4501515 DISEASES OF BRIRETORY BYSTEM 330-459
: -] 520-578 DISEASES OF THE DIGEETIVE SYBTEM 40519
Qms.rlﬁshla'l £ SE0-28 DISEASES OF THE GEMITOLURINARY SYETEM
{ -1 G30-676 COMPLICATIONS OF FREGMAMCYT, CHILDBEIRTH, 28HD THE FUERFERILM
-5 5E0-708 DISEASES OF THE SKIN AND SUBCLTAREDUS TISSLE
File !I -3 T 0-739 DISEASES OF THE MUSCULOSKELETAL STSTEM AND COMMECTIVE TISE
it | - TAD-758 COMNGEMITAL AMOMALIES
- () TED-778 CERTAIN CONDITIONS QRIGIMATIMG I THE PERIMNATAL PERIID
Halp P~ TE0-738 SVWPTOMS, SIGMS, AND ILL-DEFIMED CONDMOMS
s | - (2 S00-898 INJURY AND POISORING
! - (53 V01-v98 " CODES |
: @ (E) EROD-EQ89"E CODES (HOT APPLICAELE TC PRIMARY DIAGMOSIE =
DRgED | ]
Figure 6.

The ICD-9 Explorer adso has a search function enabling you to search by code or
text. Type the code or text string you desire in the L ookup box on the top of the
screen and click on the Sear ch button. The desired item will be outlined. Click
the left mouse button to select the outlined item. To clear al selections and begin
over, click on the Reset button.

12
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Choose population of interest

First, select the Population tab. Selectable strata include Gender, Age, Race,
Grade, and Marital Status. Service and Calendar Y ear strata along with the
Location and Occupational Group (in the filter tab) are not selectable for Disease
Summary queries. Within a stratum, you may select one, al or any combination
of values by clicking the check box next to each desired item. At least one
stratum must be set to All and one other must be set to All or multiple values (see

Figure7).

YR OMED 3.6 Discase Summary

IC0-% Explorer Popalation ] | | Reaufs ]
mmﬂml 1) Chovse Serviceis)
| = = =
e Senvice m | |
| Samminy | o Chone et graphden
Dietadled
_l'q‘miﬁ. Sander ige Raca Srade Marntal Etatus
Top Ten | [ daka [ = [ While BB [ |Singk
| [Female | lanzd Dilxck E3.E? | Iafaoied
Fopuleticon 1Ew = 5 i
v AT [ 3 ey CL-CROL-FY3) | Diher
[ [a0-3q ¥ Al =B g R [ Al
E %th:: [ 353w ¥ (AT
: | ==dll
Cromryr Hisbory 2
| I
File -I ¥ Checse Timeframe
Pont
_I U Calendar Year
Halg I L SR B u B B P
i W L3010 Years [ E .
R ' ' ' 3 | Figure 7.
; [ R U S S = T
DiGED
RESET

Submit Query

Click the Submit Query button.

Results Screen options

The Resultstab is automatically displayed after a query is submitted.

Three main Result tabs will appear - one for each type of data: Hospitalizations,
Ambulatory Data and Reportable Events).

Within each of the Result tabs there are five additional tabs (see Figure)
Counts - displays the count of the cases for the population substrata sel ected.
These are the numerators of the rate calculations.

Person Years — displays the cumulative person years of experience during the
calendar years of interest of all members of the population substrata selected.
These are the denominators of the rate calculations.

13
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Rates - displays rates of occurrence of cases (rounded to 2 significant digits) for
the popul ation substrata sel ected.

LineChart - graphs the rates in line chart format.
Bar Chart - graphs the rates in bar chart format.

m DMED 3.6 Disease Summary

Intraduction |

Disease
Burmmary

Detailed
Query

Top Ten
4

Population

Submit
Query
Query Historyl

File

Print

Help |

Ezit |

il

DIGED

Filters l ety l Hospitalizations Ambulatory Data ReponableEventsl

Ambulatory Data - Cases of Selected Diagnoses*

Data dource: Ambulatory Data Condition: Primary Diagnosis
Gender: Al Grade: Al
Age All Iarital Btatus:  All
Race: All Hervice: All
Calendar Vear: 1997-2003
Location: All

Occupation:  All

Qooutrences: All

Jump to Detail

Counts Ferson-Years Rate Line Chart

1997 1998 1999 2000 2001 2002

2003 Total

Army 202320|  417.200) 438 34| 513523 5A2.337| 563,128

535,522)3,338.477

Mavy 235743|  281,253] 307,000) 341403 346105 350,355

35230702.214276

AirForce| 327034| 363,114) 430,848 495443 430 161| 421614

500,363 3,088 477

Marines 70,580) 106,025 133110] 136911 133,734| 135113

142.335] 857808

Total 032377 1,167,691] 1,309,306] 1,497,370 1,531,337) 1,530,210

1,530,347] 9,400 038

Bar Chart

[ Figures |

Hutes: Rates are caloulatedper | 1000 > | persons peryear, Datawithombaram rabues sichuded,
*Selected Diagnoses
1. 320-330 DIEEASES OF THE HERWOUS SWSTENM AND SENSE ORGANS
4. 390-450 DIEEASES OF THE CIRCUL ATORY S¥WETEM
3. 460-519 DISEASES OF THE RESPIRATORY SWSTEM

Sonmrce: DISS 10-Iar-2004

Each Results tab has a Jump To Detail button (see Figure 8 above), which will
bring the user to the appropriate Detailed Query.

14
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o A

Results will not display on the Reportable tab if the condition chosen is not one of
the required reportable events (see Figure 9)
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Detailed Query

Hospitalization data query

Overview

In-patient data for calendar years 1990 — 2003 and monthly data from calerdar
year 2004 is a combination of the Standard Inpatient Data Record (SIDR), which
is extracted from the Composite Health Care System (CHCS) used in DoD
Military Treatment facilitates worldwide and outsourced (non DoD hospital) in
patient healthcare provided to active duty service members. CHCS exists
primarily as an administrative medical database, but it alows tracking of
frequencies, rates, and trends of disease and injury diagnoses in military
populations. Each medical record is coded with up to eight diagnosesand is
based on the health care provider's review and interpretation of results of tests,
consults, and diagnostic and therapeutic procedures. Only those in-patient records
considered complete are processed into DM SS.

Choose the Detailed Query button. Choose Hospitalizations from the drop
down menu (see Figure 10).

MDMED 3.6 Introduction

Walcams Eathing Etarad ] Disdaimar ]
Irdrochuction
Diasape
S any
Dletaded o
Chary oy
Top Ten F Anbumory Dala
Frepohshie Everls
Fopulaticn
E it
0| Cumrg
Cueey Hisbary Welcome to DMED! This program provides remote access to data
contained within the Defense Medical Surveillance System (DMSS).
File Using the tools available, you can construct customized queries of
: DOD Hospitalizations, Ambulatory clinic visits and Reportable Events.
Pirs
= Choose "Getting Started' For a review of DMED (Version 2.6) features
i and assistance in constructing queries.
Exert
FoOr customer support, contact the DMED administrator af the Fiqure 10
? Armty Medical Surveitiance ACEvity ‘Omedadmidanmsa.anmy. i’ 9 ’
DrgED
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Choose diagnosis of interest

The user may select up to 15 ICD-9 code(s) or ranges of codes from the ICD-9
Explorer tab. The ICD-9 Explorer is atree structure of 1CD-9 codes.

Clicking on the + sign next to a displayed range expands the display to show the
next level of detail. Select codes or code ranges by clicking on them with the left
mouse button. Y our selection(s) will be highlighted and appear in the Selected
Codes box on the screen. To select (or deselect) multiple codes, hold down the
Ctrl key and click on each desired code.

The ICD-9 Explorer also has a search function enabling you to search by code or
text. Type the code or text string you desire in the Lookup box on the top of the
screen and click on the Sear ch button. The desired item will be outlined. Click
the left mouse button to select the outlined item. To clear all selections and begin
over, click on the Reset button.

Decide which fields to search
Select the Diagnosis Fields to Search. 'Any of Top Three Diagnoses and 'Any
Diagnosis can only be selected with asingle ICD-9 code (i.e. alowest level code
that has no sub codes beneath it). (See Figure 11).

AED 3,6 Detailed Diery: Hespifalizations
e ry r

IC0-0 Erploréd ] Papuiation ] Flgrs | Driaplay ] Resuks |
T Tert ard ICT.2
' IT]‘:’;"‘M | _ SEARCH |
CHpsage :
Sammany | [y 00198 AL DISELSES ANDIMIURIES + || Dirgrosis Fzs to Search
Distaled =+ 001 -1 3 INFECTIOUS SO PARASITIC DISEASES j " Primury Dliaguosis
Queey 3 £ |2§ 001-008 INTEETIMAL INFECTIOUS DISEAREE ' I % Lrorod Top 5 Dinpacges® I
B 00018 TUBERCLUILOSES | 1™ &y Coegrasis
eyl 3 30 110 Piliiar Wb erculaus nfeelion '
| ; 1% Applis o Singks Cokes Onle
Population 29 M7 Pulmonsn hkerouinsis
A (2 [ 2 Other Feapisbon UbBrEUES | Selected Codes
k =528 M3 TubRcUI0sIS of meningas =nd Canal nerous sysem TETE
'3'-“*"“ -5 01 3.0 Tuberculous meringllis i
Shiary <-4 01 3.1 Tuberculoma of meningas
| Qs History i =2 MAA0 Tubemuiama of mennges, unspeciiad sEminaion
| [ EI 13.11 Tuberculama of mennges, bacthist ssam not dane
-] MA12 TussmUma of MEnn e, hachistean unkmasE
| EErin =
Paind i 2} 113,14 Tubarsulama of mannges, bacll by e
H . E] 315 Tuberzuloma of mennges, ponfimed hislaaglealky
Help Pt =] 011316 Tubarculoma of maninges, toniimmed by other methods
Eei -2 1 3.3 Tuberculorma of brai
: 3 _| 01 3.3 Tuberculous abscess of brain Err
- |Z) 01 3.9 Tuberculomea of apinal cond g
$ 1] BTN 1A Tonerenlng & sheraes of sninal mm_ ; '_!
i ' Figure 11.
|

17



DMED Users Guide

Choose population of interest
First, select the Population tab. Strata include Service, Gender, Age, Race,
Grade, Marital Status and Calendar Y ear. Within a stratum, you may select one,
all or any combination of values by clicking the check box next to each desired

item. At least one stratum must be set to All and one other must be set to All or
multiple values (see Figure 12).

FROMED 3.6  Detailed Query: Hospitalizations
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Bt W La=110 vears oo | lmon | @00l | 2002 | 000 v A
" [ Naar 2004 fcourds onhd Figure 12.
ﬂ#ﬂ _ |
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Select filters

First, select the Filter tab. The user may select up to five locations and five
occupations from the Filter tab. Both the Location and Occupation explorer are
laid out in atree structure. Clicking on the + sign next to a displayed range
expands the display to show the next level of detail. Select location or occupation
by clicking on them with the left mouse button. Y our selection(s) will be
highlighted and appear in the Selected box on the screen. To select (or deselect)
multiple codes, hold down the Ctrl key and click on each desired code.
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DMED will default to “All Locations” and “All Occupation Groups” unless
otherwise specified. To clear your selections, click on the reset button (see figure

13).
_E BMED 3.6  Detailed Ouery: Hospitalizations
IC0-a Bpiover | Fogulation Filters Disolar | Resuts |
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Fopudstion - ALY 2} Combat Engingsang, Danaral
| -1 JAPAN _l - =) Artliery and cunnaey
; - HORES - [=] Reekiat Arflleny
ﬂ %"::?'n v 3 P, (=) Wiz Ak, DpRrating Srem
-2 NI ) A Creaw, Gerarsd
Crmese -2 FORTUGHL ) Pilets and Marigalors
i[5y PUERTO RICS [ | = Anatciains | l..'.|

ile Enlacisd Snalectad
CAERILR Lrmor ard &mrphibious, Seneral
LM

Gy Mty
_ e |
_ Pan |
T || e
_ = |
¥

Ocrumence Fler-

W Al OciETentes ™ Flrst Geciirience

__ Reest Figure 13.

Decide first vs. all occurrences
Select 'All Occurrences or 'First Occurrence. First Occurrence Rates are
calculated using only the first documented hospitalizations for specific conditions
of interest (since 1990). Thus, if an individual was hospitalized for the same
condition more than once (since 1990), only the first occurrence would be
counted. To optimize response times, 'First Occurrence' queries are restricted to
single three, four or five digit ICD-9 codes. Thus, ranges of codes and multiple
code selections are not allowed.

Choose display options

First, select the Display tab. Next, select the X-axisand “ By Value” variables.
The X-axis options include all strata for which you selected All. Your By Value
options are any strata for which you selected All or multiple values. The same
variable cannot be used to define the X axis and By Values. To set the strata
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values back to the defaults, click on the Reset button. A sample line chart will
display the layout of your X and By-value (see Figure 14).
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Submit Query
Click the Submit Query button.

Results Screen options

The Results tab is automatically displayed after a query is submitted.

The Results tab contains five sub-tabs (see Figure 15 on next page...).
Counts - displays the count of the cases for the population substrata sel ected.
These are the numerators of the rate calculations.

Person Years — displays the cumulative person years of experience during the
calendar years of interest of all members of the population substrata selected.
These are the denominators of the rate calculations.

Rates - displays rates of occurrence of cases (rounded to 2 significant digits) for
the popul ation substrata sel ected.

Line Chart - graphs the ratesin line chart format.

Bar Chart - graphs the rates in bar chart format.
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Ambulatory Data query

Overview

Out-patient data for calendar years 1997 — 2003 and mont hly data from calendar
year 2004 is a combination of the Standard Ambulatory Data Record (SADR)
which is extracted from the Ambulatory Data System (ADS) and the Composite
Health Care System (CHCS) used in DoD Military Treatment facilitates
worldwide and outsourced (non-DaoD clinic) out-patient healthcare provided to
active duty service members. ADS exists primarily as an administrative medical
database, but it allows tracking of frequencies, rates, and trends of disease and
injury diagnoses in military populations. Each medical record is coded with up to
four diagnoses chosen from alist of relevant diagnoses for specific clinics. Clinic
staff fill out patient encounter information (including diagnosis) onto forms which
are scanned into the ADS database. Only those out-patient records considered
complete are processed into DM SS.

Choose the Detailed Query button. Choose Ambulatory Data from the drop
down (see Figure 16).
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Choose diagnosis of interest

The user may select up to 15 ICD-9 code(s) or ranges of codes from the ICD-9
Explorer tab. The ICD-9 Explorer is atree structure of 1CD-9 codes.

Clicking on the + sign next to a displayed range expands the display to show the
next level of detail. Select codes or code ranges by clicking on them with the left
mouse button. Y our selection(s) will be highlighted and appear in the Selected
Codes box on the screen. To select (or deselect) multiple codes, hold down the
Ctrl key and click on each desired code.

The ICD-9 Explorer also has a search function enabling you to search by code or
text. Type the code or text string you desire in the L ookup box on the top of the
screen and click on the Sear ch button. The desired item will be outlined. Click
the left mouse button to select the outlined item. To clear all selections and begin
over, click on the Reset button.

Decide which fields to search

Select the Diagnosis Fields to be Search. 'Any Diagnosis can only be selected

with asingle ICD-9 code (i.e. alowest level code that has no subcodes beneath it)
(see Figure 17 on next page).
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FROMED 3.6 Detailed Query: Ambulatory Data
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Figure 17.

Choose population of interest

First, select the Population tab. Strata include Service, Gender, Age, Race,

Grade, Marital Status and Calendar Y ear. Within a stratum, you may select one,
all or any combination of values by clicking the check box next to each desired
item. At least one stratum must be set to All and one other must be set to All or

multiple values (see figure 18 on next page).
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Select filters

First, select the Filter tab. The user may select up to five Locations and five
Occupations from the Filter tab. Both the Location and Occupation explorer are
laid out in atree structure. Clicking on the + sign next to a displayed range
expands the display to show the next level of detail. Select location or occupation
by clicking on them with the left mouse button Y our selection(s) will be
highlighted and appear in the Selected box on the screen. To select (or deselect)
multiple codes, hold down the Ctrl key and click on each desired code. DMED
will default to “All Locations’ and “All Occupation Groups’ unless otherwise
specified. To clear your selections, click on the reset button (see figure 19 on next
page).
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Decide first vs. all occurrences

Select 'All Occurrences or 'First Occurrence’. First Occurrence Rates are
calculated using only the first documented hospitalizations for specific conditions
of interest (since 1990). Thus, if an individua was hospitalized for the same
condition more than once (since 1990), only the first occurrence would be
counted. To optimize response times, 'First Occurrence' queries are restricted to
single three, four or five digit ICD-9 codes. Thus, ranges of codes and multiple
code selections are not allowed.

Choose display options
First, select the Display tab. Next, select the X-axisand “ By Value” variables.
The X-axis options include al strata for which you selected All. Your By Value
options are any strata for which you selected All or multiple values. The same
variable cannot be used to define the X axis and By Values. To set the strata
values back to the defaults, click on the Reset button. A sample line chart will
display the layout of your X and By-value (see Figure 20 on next page).
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Submit Query
Click the Submit Query button.

Results Screen options
The Results tab is automatically displayed after a query is submitted.
The Results tab contains five sub-tabs (see Figure 21 on next page).
Counts - displays the count of the cases for the population substrata sel ected.
These are the numerators of the rate calculations.
Person Years — displays the cumulative person years of experience during the
calendar years of interest of all members of the population substrata sel ected.
These are the denominators of the rate calculations.
Rates - displays rates of occurrence of cases (rounded to 2 significant digits) for
the population substrata selected.
LineChart - graphs the rates in line chart format.
Bar Chart - graphs the rates in bar chart format.
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Figure 21.

Reportable event query

Overview

Medical events meeting DoD reporting requirements are transmitted within each
Service to a central location by Service-specific reporting programs. These
programs exist to compile a reportable event surveillance database used to record
and track events of interest in the military. Criteria (below) were formulated by
each Service to establish a consensus list of DoD reportable events. Currently,
Army reportable event data for calendar years 1995 to present, and Navy and Air
Force data from calendar years 2000 to present are available in DMSS.

Criteria for the Selection of Reportable Medical Events

First, there must be a clear case definition and a single standard code (in the
International Classification of Diseases, 9™" revision);
Second, an intervention must be available and/or a public health response

indicated;

Third, a sufficient, timely source of information must not already exist; and

Fourth, the condition/event must --

- represent an inherent, significant threat to the public’s health (e.g.,
potential to affect large numbers of people, to be efficiently transmitted
within a population, to have severe/life threatening clinical

manifestations); OR

- represent asignificant military operational threat (e.g., potential to disrupt
military training, deployment, or operations); OR
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- be commonly reportable by state or federal laws, regulatiors, or
guidelines.

Choose the Detailed Query button. Choose Reportable Events from the drop
down (see Figure 22).
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Choose diagnosis of interest
The user may select up to 15 ICD-9 codes from the Repor table Events Explor er
tab. The Reportable Events Explorer is a tree structure of 1CD-9 codes
representing the required reportable events.

Select codes by clicking on them with the left mouse button. Y our selection(s)
will be highlighted and appear in the Selected Codes box on the screen. To select
(or deselect) multiple codes, hold down the Ctrl key and click on each desired
code (see Figure 23 on the next page).
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PR OMED 3.6 Detailed Query: Reportabile Events
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The Reportable Events Explorer also has a search function enabling you to search
by code or text. Type the code or text string you desire in the L ookup box on the
top of the screen and click on the Sear ch button. The desired item will be
outlined. Click the left mouse button to select the outlined item. To clear al

selections and begin over, click on the Reset button.

Choose population of interest

First, select the Population tab. Strata include Service, Gender, Age, Race,

Grade, Marital Status and Calendar Y ear. Within a stratum, you may select one,
all or any combination of values by clicking the check box next to each desired
item. At least one stratum must be set to All and one other must be set to All or

multiple values (see figure 24).
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Select filters

First, select the Filter tab. The user may select up to five Locations and
five Occupations from the Filter tab. Both the Location and Occupation
explorer are laid out in a tree structure. Clicking on the + sign next to a
displayed range expands the display to show the next level of detail.
Select location or occupation by clicking on them with the left mouse
button. Your selection(s) will be highlighted and appear in the Selected
box on the screen. To select (or deselect) multiple codes, hold down the
Ctrl key and click on each desired code. DMED will default to “All
Locations” and “All Occupation Groups” unless otherwise specified. To
clear your selections, click on the reset button (see Figure 25).
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Choose display options
First, select the Display tab. Next, select the X-axisand “ By Value” variables.
The X-axis options include all strata for which you selected All. Your By Value
options are any strata for which you selected All or multiple values. The same
variable cannot be used to define the X axis and By Values. To set the strata
values back to the defaults, click on the Reset button. A sample line chart will
display the layout of your X and By-value (see Figure 26 on next page).
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Submit Query
Click the Submit Query button.

Results Screen options

The Results tab is automatically displayed after a query is submitted.
The Results tab contains five sub-tabs (see Figure 27 on next page):
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Counts - displays the count of the reported cases for the population substrata
selected. These are the numerators of the rate calculations.

Person Years — displays the cumulative person years of experience during the
calendar years of interest of al members of the population substrata selected.
These are the denominators of the rate calculations.

Rates - displays rates of occurrence of cases (rounded to 2 significant digits) for
the population substrata selected.

Line Chart - graphs the rates in line chart format.

Bar Chart - graphs the rates in bar chart format.
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Top Ten Query

Overview
The Top Ten query displays the ten most commonly occurring conditions for
specified populations. 1CD-9 codes for this query are specified at the 3-digit ICD-
9 level only. Since the user does not select specific diagnoses, the ICD-9 and
Reportable Events Explorer Tabs are not available for this kind of query. The
following steps are necessary to perform a Top Ten Diagnoses query.

Choose the Top Ten button on the left side of the screen. Choose the data of
interest: Hospitalizations, Ambulatory Data or Reportable Events (see Figure 28).
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Tioed T ¥or Regacrlanie Evams
a Submri
pREE e
sy Hietony Welcome to DMED! This program provides remote access to data
contained within the pefense Medical surveillance System (DMSSL.
o Using the tools avallable, you can construct customized queries of
v = DOD Hospitalizations, Ambulatory clinic visits and Reportable Events.
u Choose 'Getting Started' for a review of DMEC (Varzion 2.6] Features
o and assistance in constructing queries.
Bzt
: For customer support, contact the DMED admiimistrator at the -
‘? Army Medical Surveiliance ACEVIty ‘dmedadm @amsa. army.mil’ Figure 28.
DIRgED

Hospitalization data query

Choose population of interest
Firgt, select the Population tab. Strata include Service, Gender, Age, Race,
Grade, Marital Status and Calendar Y ear. Within a stratum, you may select one,
all or any combination of values by clicking the check box next to each desired
item. At least one stratum must be set to All and one other must be set to All or
multiple values.
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Submit Query
Click the Submit Query button.

Results Screen
Top Ten Query results are displayed in tabular format only (see Figure 29).

MMTDMED 3.6 Top Ten for Hospitalizations

Figure 29.




DMED Users Guide

Ambulatory Data query

Choose population of interest
The Population tab is automatically selected. Strata include Service, Gender,
Age, Race, Grade, Marital Status and Calendar Y ear. By default, al strataare
selected when you enter thistab. Within a stratum, you may select one, all or any
combination of values by clicking the check box next to each desired item (See

figure 30).
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Select filters

First, select the Filter tab. The user may select up to five Locations, five
Occupations, and one Mgjor |CD-9 category from the Filter tab. Both the
Location and Occupation explorer are laid out in atree structure. Clicking on the
+ sign next to a displayed range expands the display to show the next level of
detail. Select location or occupation by clicking on them with the left mouse
button. Y our selection(s) will be highlighted and appear in the Selected box on
the screen. To select (or deselect) multiple codes, hold down the Ctrl key and
click on each desired code. DMED will default to “All Locations” and “All
Occupation Groups’ unless otherwise specified. To clear your selections, click on
the reset button (see Figure 31 on next page).
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Exit
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Choose display options

For Top Ten Query results, since they are displayed in tabular format only, the
Display tab is greyed-out, and no selections on the Display tab are necessary.

Submit Query
Click the Submit Query button.

Results Screen
Top Ten Query results are displayed in tabular format only (see Figure 32).
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Reportable event query

Choose population of interest
The Populationtab is automatically selected. Strata include Service, Gender,
Age, Race, Grade, Marital Status and Calendar Y ear. Within a stratum, you may
select one, al or any combination of values by clicking the check box next to each
desired item (see Figure 33 on next page).
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RESET |

Select filters

First, select the Filter tab. The user may select up to five Locations, five
Occupations, and one Major |CD-9 category from the Filter tab. Both the
Location and Occupation explorer are laid out in atree structure. Clicking on the
+ sign next to a displayed range expands the display to show the next level of
detail. Select location or occupation by clicking on them with the left mouse
button. Your selection(s) will be highlighted and appear in the Selected box on
the screen. To select (or deselect) multiple codes, hold down the Ctrl key and
click on each desired code. DMED will default to “All Locations” and “All
Occupation Groups’ unless otherwise specified. To clear your selections, click on
the reset button (see Figure 34 on next page).
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Repurable Events

% DMED 3.6 Top Ten for Reportable Events
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Reset

Choose display options

For Top Ten Query results, since they are displayed in tabular format only, the
Display tab is greyed-out, and no selections on the Display tab are necessary.

Submit Query

Click the Submit Query button.

Result Screen

Top Ten Query results are displayed in tabular format only (see Figure 35).
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MMDMED 3.6 Top Ten for Reportable Events

Figure 35.
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Additional Features

Population Statistics

DMED also alows queries on population statistics (the total number of person
years documented in the database for the population specified). No diagnosis
information is included in these figures.

To obtain population statistics:

1. Select the Population button

2. The DMED will automatically go to the Populationtab. Click on the check box
next to the population you wish to study (see Figure 36). Select desired Location
and Occupational Group from the Filter tab.
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3. Select the Submit Query button.

4. Query results will be displayed on the Results tab in table format (see Figure 37).

MMDMED 3.6 Population S

Figure 37.
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File / Print Options

Opening queries
To open apreviousy saved query: choose the File button then choose Open from
the drop down. When this option is selected, afile panel listing all saved queries
appears. When the desired query is selected, the | CD-9/Reportable Events
Explorer, Population, Filter and Results tabs are set to the saved values.

Saving queries

To save aquery: choose the File button then choose Save from the drop down.
When this option is selected, afile panel appears alowing you to select the
directory in which to save the query file.

Exporting Data
To export the results of a query to atab-delimited ASCI| text file: choose the File
button then choose Export from the drop down. Thisfileis easily migrated into
commonly used spreadsheet programs (e.g. Excel) for further analysis, graphing
and printing. When this option is selected, afile panel appears alowing you to
select the directory in which to save the query results file,

Printing results

Choose the Print button to print results screens. Choose landscape mode to view
the entire printout.



